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Viglen, EMC and the ‘CE’ mark

CE Marking

European standards are being harmonised across borders. If products comply with the same standards in all
European countries, product exporting and importing is made simple - paving our way to a common market. If you buy
a product with a 'CE' mark on it (shown below), on the box, in the manual, or on the guarantee - it complies with the
currently enforced directive(s).

Introduction to EMC

EMC (Electromagnetic Compatibility) is the term used to describe certain issues with RF (Radio Frequency) energy.
Electrical items should be designed so they do not interfere with each other through RF emissions. E.g. If you turn on
your microwave, your television shouldn't display interference if both items are CE marked to the EMC directive.

If emitted RF energy is not kept low, it can interfere with other electrical circuitry - E.g. Cars Automatic Braking
Systems have been known to activate by themselves while in a strong RF field. As this has obvious repercussions
ALL electrical products likely to cause RF related problems have to be 'CE' marked from 1st January 1996 onwards.

If a product conforms to the EMC directive, not only should its RF emissions be very low, but its immunity to RF energy
(and other types) should be high. The apparatus has to resist many 'real world' phenomena such as static shocks and
mains voltage transients.

Viglen’s Environment laboratory

To gain a 'CE' mark, the Viglen computer range has had to undergo many difficult tests to ensure it is
Electromagnetically Compatible. These are carried out in the in-house 'Environment lab' at Viglen Headquarters. We
have made every effort to guarantee that each computer leaving our factory complies fully with the correct standards.
To ensure the computer system maintains compliance throughout its functional life, it is essential you follow these
guidelines.

» Install the system according to Viglen'’s instructions
» If you open up your Viglen:

Keep internal cabling in place as supplied.

Ensure the lid is tightly secured afterwards

Do not remove drive bay shields unless installing a 'CE' marked peripheral in its place

The clips or ‘bumps' around the lips of the case increase conductivity - do not remove or damage.
Do not remove the ferrite ring from the L.E.D cables.

Only use your Viglen computer with '‘CE' marked peripherals

VVVVVYY

This system has been tested in accordance with European standards for use in residential and light industrial areas-
this specifies a 10 meter testing radius for emissions and immunity. If you do experience any adverse affects which
you think might be related to your computer, try moving it at least 10 meters away from the affected item. If you still
experience problems, contact Viglen’s Technical Support department who will put you straight through to an EMC
engineer - s/he will do everything possible to help. If modifications are made to your Viglen computer system, it might
breach EMC regulations. Viglen take no responsibility (with regards to EMC characteristics) of equipment which has
been tampered with or modified.

This symbol on the product or on its packaging indicates that the product shall not be treated as household
waste. Instead it shall be handed over to the applicable collection point for recycling of electrical and
electronic equipment. By ensuring this product is disposed of correctly, you will help prevent potential
negative consequences for the environment and human health, which could otherwise be caused by
inappropriate waste handling of this product. The recycling of materials will help to conserve natural

mmmm  'CSOUrCES. For more detailed information about recycling of this product, please contact your local city
office, your household waste disposal service or XMA Ltd.
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Copyrights and Trademarks

Please note
The material in this manual is subject to change without notice.

Trademarks

Microsoft, Windows XP Pro, Windows Vista, Windows 7, Windows 8/8.1, Windows 10
and MS-DOS are registered trademarks of Microsoft Corporation. IBM PC, XT, AT and
PS/2 are trademarks of International Business Machines Corporation. Core i3/i5/i7™ and
Pentium® are registered trademarks of Intel® Corporation. All other trademarks are
acknowledged. Genie, Vig, Viglen, and Omnino are trademarks of Viglen Limited.

Copyright and Patents

This manual and all accompanying software and documentation are copyrighted and all
rights reserved. This product, including software and documentation, may not, in whole
or in part, be copied, photocopied, translated or reduced to any electronic or machine-
readable form, without prior written consent except for copies retained by the purchaser
for backup.

© Copyright 2015 Viglen Limited
All Rights Reserved

Vig711W Manual Version 1.0
Printed in the United Kingdom
Original power supply
Liability

No warranty or representation, either expressed or implied, is made with respect to this
documentation, its quality, performance, merchantability or fitness for a particular
purpose. As a result the documentation is licensed as is, and you, the licensee, are
assuming the entire risk as to its quality and performance. The vendor reserves the right
to revise this operation manual and all accompanying software and documentation and
to make changes in the content without obligation to notify any person or organisation of
the revision or change.

In no event will the vendor be liable for direct, indirect, special, incidental or
consequential damages arising out of the use or inability to use this product or
documentation, even if advised of the possibility of such damages. In particular, the
vendor shall not have liability for any hardware, software or data stored or used with the
product, including the costs of repairing, replacing or recovering such hardware, software
or data.
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Chapter 1: Motherboard Overview

Introduction

This manual describes the Viglen Vig710W motherboard inside your computer. The
motherboard is the most important part of your computer. It contains the CPU, memory
and graphics circuitry that make the computer work in the correct manner.

The Vig710W motherboard with Mini-ITX form factor offers premium features. Integrated
Graphics via HDMI, High Definition Audio via 2 flexible audio jacks and integrated
10/100/1000 network connection, as well as 2 USB 3.0 ports and 2 USB 2.0 ports to
enrich your multimedia experience.

The Vig710W supports 4" generation Intel Core i3, i5, i7, Pentium and Celeron
processors as well as being Microsoft Windows 7 Premium WHQL certified.

This manual contains technical information about the Viglen Vig710W motherboard and
other hardware components inside your computer. If you are new to computers we
recommend that you read the user guide first. If you are an experienced computer user
this manual should provide all the information you will need to perform simple upgrades
and maintenance.

We hope that this manual is both readable and informative. If you have any comments
for suggestions about how we could improve the format then please fill out the form at
the back of the manual and send it to us.

Above all we hope that you enjoy using your Viglen computer.
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Feature Summary
Form factor:
o Thin Mini-ITX Form Factor: 170mm x 170mm
Processor:
e Intel® Core™ i7, Intel® Core™ i5, Intel® Core™ i3, Intel® Pentium®, Intel®
Celeron® processors in an LGA1150 socket
e Integrated graphics processing (processors with Intel® Graphics Technology)

e External graphics interface controller
e Integrated memory controller

Chipset

e Intel® H81 Express Chipset

Memory
e Two SO-DIMM Slots
e Memory Module (SO-DIMM) sockets — only supports Voltage 1.5V
e Support for DDR3 1066/1333/1600 MHz SO-DIMMs
e Maximum 32GB Memory Size

Graphics

e Integrated graphics support for processors with Intel® graphics technology
e 1x HDMI® port supporting @ maximum resolution of 1920x1200@60HZ

Audio

Integrated HD audio codec by Realtek® ALC662

Support JACK detection, multi-streaming and anti-pop functions
With ALC105 amplifier to support speakers

Front panel header

LAN
e Gigabit (10/100/1000 Mbits/s) LAN subsystem using the Realtek® RTL8111F
Gigabit Ethernet Controller

Rear I/0O Ports
e 1x19V Power Port
1x HDMI
1x Gigabit LAN (Realtek® RTL8111F)
1x Microphone
1x Headphone/Speaker
2x USB 3.0 Ports
2x USB 2.0 Ports
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Internal Connectors

1 x Front Panel Connector (Reset, HD LED, Power LED, Power On/Off) (2 x 5 pin)
1 x 4-pin Chassis Speaker Connector

1 x Front Panel Audio Connector (2 x 5 pin)

2 x USB 2.0 Connector Support 4 x USB 2.0 Ports (2 x 5 pin)
1 x USB 2.0 Connector Supports 1 x USB 2.0 Port (1 x 5 pin)
2 X SATA 6Gb/s (SATAIII) Ports

1 x 5-pin DMIC

1 x 40-pin LVDS Connector

1 x 4-pin CPU Fan Connector

1 x 4-pin System Fan Connector

1 x 8-pin Display Brightness Connector

1 x 3-pin Backlight Inverter Voltage Selection Connector

1 x 3-pin SATA Power_ODD Connector

1 x 4-pin SATA Power_HDD Connector

1 x 3-pin Panel Voltage Selection Connector

1 x 3-pin Monitor Switch Connector

1 x Flat Panel Display Configuration Jumper (3 X 4 pin)

1 x 3-pin Monitor Switch Connector

1 x 3-pin Clear CMOS Header & Jumper

1 x TPM Connector (2 x8 pin)

Expansion Capabilities

e 1 x Half Mini PCI Express slot supports PCle signal
e 1 x Full Mini PCI Express slot supports PCle signal (Default)

BIOS
e AMI EFI BIOS
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Processor

The motherboard is designed to support the Intel Core i7/i5/i3, Pentium and Celeron
processors in an LGA1150 socket.

Other processors may be supported in the future. This board is designed to support
processors with a maximum TDP of 45 W.

Chipset

Intel H81 Express Chipset with Intel Flexible Display Interconnect (Intel FDI) and
Direct Media Interface (DMI) interconnect provides interfaces to the processor, display,
USB, SATA, LPC, LAN, and PCI Express interfaces. The Intel H81 Express

Chipset is a centralized controller for the board’s 1/O paths.

Memory
The board has two SO-DIMM sockets and supports the following memory features:
e Two 204-pin DDR3 SDRAM Small Outline Dual Inline Memory Module (SODIMM)

sockets
e Support for DDR3 1600 MHz, DDR3 1333 MHz, and DDR3 1066 MHz SODIMMs
e Support for 1GB, 2GB, 4GB & 8GB memory technology
e Support for up to 32 GB of system memory with two 16GB SO-DIMMs
e Support for non-ECC memory
e Support for 1.5 V (standard voltage) JEDEC memory
e Support for XMP memory

NOTE

To be fully compliant with all applicable DDR SDRAM memory specifications, the board
should be populated with SO-DIMMs that support the Serial Presence Detect (SPD) data
structure. This allows the BIOS to read the SPD data and program the chipset to
accurately configure memory settings for optimum performance. If non-SPD memory is
installed, the BIOS will attempt to correctly configure the memory settings, but
performance and reliability may be impacted or the SO-DIMMs may not function under
the determined frequency.
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Memory Configurations

The 4th Intel Core generation Intel Core processor families support the following types of
memory organization:

* Dual channel (Interleaved) mode. This mode offers the highest throughput for real world
applications. Dual channel mode is enabled when the installed memory capacities of
both SO-DIMM channels are equal. Technology and device width can vary from one
channel to the other but the installed memory capacity for each channel must be equal. If
different speeds SO-DIMMs are used between channels, the slowest memory timing will
be used.

« Single channel (Asymmetric) mode. This mode is equivalent to single channel
bandwidth operation for real world applications. This mode is used when only a single
SO-DIMM s installed or the memory capacities are unequal. Technology and device
width can vary from one channel to the other. If different speed SO-DIMMs is used
between channels, the slowest memory timing will be used.

* Flex mode. This mode provides the most flexible performance characteristics. The
bottommost DRAM memory (the memory that is lowest within the system memory map)
is mapped to dual channel operation; the topmost DRAM memory (the memory that is
nearest to the 8 GB address space limit), if any, is mapped to single channel operation.
Flex mode results in multiple zones of dual and single channel operation across the
whole of DRAM memory. To use flex mode, it is necessary to populate both channels.

Graphics Subsystem
The board supports system graphics through Intel Graphics Technology.

Integrated Graphics
The board supports integrated graphics through the Intel® Flexible Display Interface
(Intel® FDI) for processors with Intel Graphics Technology.

NOTE: If using a processor with integrated graphics, the board will support only two of
the integrated graphics interfaces simultaneously: VGA, HDMI.

High-Definition Multimedia Interface (HDMI)

The HDMI port supports standard, enhanced, or high-definition video, plus multichannel
digital audio on a single cable. It is compatible with all ATSC and DVB HDTV standards
and supports 8 full range channels at 24-bit/96kHz audio of lossless audio formats such
as Dolby TrueHD or DTS HD Master Audio. The maximum supported resolution is 1920
x 1200 at 60 Hz refresh (WUXGA).

The HDMI port is compliant with the HDMI 1.3 specification.
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Audio Subsystem

The motherboard supports Intel High Definition Audio through a Realtek ACL662 audio
codec. The following software features are supported

o Compatible with Windows Vista Premium (complies with Microsoft WLP 3.08
specifications)

WaveRT-based audio function driver and logo ready for Windows Vista
Direct Sound 3D compatible

A3D™ compatible

I3DL2 compatible

HRTF 3D Positional Audio

Friendly user interface for 2-foot or 10-foot remote control applications
Emulation of 26 sound environments to enhance gaming experience

10 Software Equalizer Bands

Voice Cancellation and Key Shifting in Karaoke mode

Windows Vista style configuration panel to improve user experience
Microphone Acoustic Echo Cancellation (AEC), Noise Suppression (NS), and
Beam Forming (BF) technology for voice application

« Features Dolby® Digital Live and DTS® CONNECT " software (Optional)

« Features Dolby® Home Theater software (Optional)

These audio connectors are used for audio devices. It is easy to differentiate between
audio effects according to the colour of audio jacks.

Figure 1. Audio Connectors

e Line-Out (Green) - Line Out, is a connector for speakers or headphones.

e Mic (Pink) - Mic, is a connector for microphones.
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LAN Subsystem

The ethernet controllers support the following features:

+ 10/100/1000 BASE-T IEEE 802.3 compliant

RJ-45 LAN Connector LEDs

The two LEDs are built into the RJ-45 LAN connector located on the back panel. These
LEDs indicate the status of the LAN as shown in Table 1.

A B

Item | Description

A Link/Activity LED (Green)
B Link Speed LED (Orange/Yellow)

Figure 2: LAN Connector LED Locations

Table 1: LAN LED Status

LED LED Colour LED State Description
Link Green Off LAN activity is occurring.
On LAN link is established.
Blinking LAN activity is occurring.
Data Greenlyellow 10 Mb/s data rate is selected.
rate 100 Mb/s data rate is selected.
1000 Mb/s data rate is selected.

V1.0 Vig711W Motherboard Manual
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Universal Serial Bus (USB)

The motherboard supports up to Eight USB ports. The port arrangement is a follows:

e Two USB 3.0 ports are implemented with stacked back panel connectors

e Two USB 2.0 ports are implemented with stacked back panel connectors

e Five USB 2.0 front panel ports are implemented through three dual-port internal
headers

NOTE: Computer systems that have an unshielded cable attached to a USB port may
not meet FCC Class B requirements, even if no device or a low-speed (sub-channel)
USB device is attached to the cable. Use shielded cable that meets the requirements for
high-speed (fully rated) devices.

SATA Support

The board provides two 3GB/s SATA connectors, which support one device per
connector.

NOTE: By default the SATA mode is set to AHCI in the BIOS to improve system
performance. During Microsoft Windows XP installation, you must press F6 to install the
AHCI drivers. Both Microsoft Windows Vista and Microsoft Windows 7 include the
necessary RAID drivers for both AHCI and RAID without the need to install separate
RAID drivers using the F6 switch in the operating system installation process. It is
advised to install the latest AHCI drivers to improve system performance.

Expansion Slots
The motherboard provides the following expansion capability:

e One PCI Express Half-Mini Card slot
e One PCI Express Full-Mini Card slot

Real-Time Clock, CMOS SRAM, and Battery

A coin-cell battery (CR2032) powers the real-time clock and CMOS memory. When the
computer is not plugged into a wall socket, the battery has an estimated life of three
years. When the computer is plugged in, the standby current from the power supply
extends the life of the battery.

The clock is accurate to £ 13 minutes/year at 25 °C with power applied through the
power supply 5V STBY rail.

NOTE: If the battery and AC power fail, date and time values will be reset and the user
will be notified during POST. When the voltage drops below a certain level, the BIOS
Setup program settings stored in CMOS RAM (for example, the date and time) might not
be accurate. Replace the battery with an equivalent one.
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BIOS

The BIOS provides the Power-On Self-Test (POST), the BIOS Setup program, and the
PCI/PCI Express and SATA auto-configuration utilities. The BIOS is stored in the Serial
Peripheral Interface (SPI) Flash memory device.

SATA Auto Configuration

If you install a SATA device (such as a hard disk drive) in your computer, the auto-
configuration utility in the BIOS automatically detects and configures the device for your
computer. You do not need to run the BIOS Setup program after installing a SATA
device. You can override the auto-configuration options by specifying manual
configuration in the BIOS Setup program.

BIOS Security Passwords

The BIOS includes security features that restrict whether the BIOS Setup program can
be accessed and who can boot the computer. A supervisor password and a user
password can be set for the BIOS Setup and for booting the computer, with the following
restrictions:

e The administrator password gives unrestricted access to view and change all Setup
options. If only the administrator password is set, pressing <Enter> at the password
prompt of Setup gives the user restricted access to Setup.

e If both the administrator and user passwords are set, you must enter either the
supervisor password or the user password to access Setup. Setup options are then
available for viewing and changing depending on whether the supervisor or user
password was entered.

e Setting a user password restricts who can boot the computer. The password prompt
is displayed before the computer is booted. If only the supervisor password is set, the
computer boots without asking for a password. If both passwords are set, you can
enter either password to boot the computer.

V1.0 Vig711W Motherboard Manual 12



System Board Components

A BCD

Table 2: Motherboard Connectors

E F

W VU T SR

Figure 3: Motherboard Layout

A | Front Panel Audio Header Q | Front Panel Display Selector
B | Microphone R | LVDS Connector
C | Speaker S | Monitor Switch Selector
D | USB 2.0 Port T | Display Brightness Header
E | LAN Port U | Invertor Voltage Selector
F | USB 3.0 Port V | USB2.0_12 Header
G | HDMI Port W | CPU Socket
H | External Power Connector X | USB2.0_34 Header
I USB2.0 Single Header Y | Mini PCI-E Full-card Slot
J | SATA Ports Z | TPM Connector Header
K | SoDIMM Slots AA | Mini PCI-E Half-card Slot
L | SATA Power_HDD AB | Clear_CMOS
M | SATA Power_ODD AC | DMIC Header
N | System Fan Header AD | CPU Fan Header
O | LCD Voltage Selector AE | Chassis Speaker Connector
P | Front Panel Header AF | Battery Connector
V1.0 Vig711W Motherboard Manual 13



Back Panel Connectors

The Motherboard external 10 connectors are attached to a metallic 1/O shield. This
shield serves several purposes:

It protects the sensitive Motherboard from any external EMC interference.

It stops the computer from interfering with other electrical devices.

It allows the Motherboard to be easily upgraded in the future without having to
resort to buying a whole new case. Simply change the I/O shield to match the
Motherboard.

Power Jack — the board can be powered through a 19 V DC connector on the back panel.
The back panel DC connector is compatible with a 7.4 mm/OD (outer diameter) and 5.1
mm/ID (inner diameter) plug, where the inner contact is +19 (x10%) V DC and the shell is
GND. The maximum current rating is 12 A.

Figure 4: Back Panel Connectors

HDMI Port - The High-Definition Multimedia Interface (HDMI) is an all-digital audio/video
interface capable of transmitting uncompressed streams. HDMI supports all TV format,
including standard, enhanced, or high-definition video, plus multi-channel digital audio on a
single cable.

USB 3.0 Ports - The USB 3.0 ports are for attaching USB devices such as keyboard,
mouse, or other USB compatible devices.

LAN Port - The standard RJ-45 LAN jack is for connection to the Local Area Network (LAN).
You can connect a network cable to it.

USB 2.0 Ports - The USB 2.0 ports are for attaching USB devices such as keyboard,
mouse, or other USB compatible devices.

Audio Ports - These audio connectors are used for audio devices (MIC-IN, LINE-OUT).

Note:

The back panel audio line out connectors is designed to power headphones or amplified
speakers only. Poor audio quality occurs if passive (non-amplified) speakers are connected to
this output.
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Chapter 2: System Board Options

The Vig710W motherboard is capable of accepting Intel® Core i3, i5, i7 processors and
Intel Pentium processors. RAM can be upgraded to a maximum of 16GB using DDR3
1066, 1333MHz or 1600MHz Non ECC Unbuffered memory.

WARNING!

Unplug the system before carrying out the procedures described in this chapter.
Failure to disconnect power before you open the system can result in personal
injury or equipment damage. Hazardous voltage, current, and energy levels are
present in this product. Power switch terminals can have hazardous Voltages
present even when the power switch is off.

The procedures assume familiarity with the general terminology associated with
personal computers and with the safety practices and regulatory compliance
required for using and modifying electronic equipment.

Do not operate the system with the cover removed. Always replace the cover
before turning on the system.

As the colours of the wires in the mains lead of this computer may not correspond with the
coloured markings identifying the terminals in your plug precede as follows:

The wire which is coloured green-and-yellow must be connected to the terminal in the plug
which is marked by the letter E or by the safety Earth symbol Q or coloured green or green-
and-yellow.

The wire which is coloured blue must be connected to the terminal which is marked with the
letter N or coloured black.

The wire which is coloured brown must be connected to the terminal which is marked with the
letter L or coloured red.

A CAUTION!
The Viglen Vig710W motherboard
and associated components are

sensitive electronic devices. A small
static shock from your body can
cause expensive damage to your
equipment.
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BEFORE YOU BEGIN

Make sure you are earthed and free of static charge before you open the computer case.
If you are unsure about upgrading your computer, return it to Viglen so a qualified
engineer can perform the upgrade.

STEPS TO TAKE TO PREVENT STATIC DISCHARGE:

1. The best way to prevent static discharge is to buy an anti-static strap from your local
electrical shop. While you are wearing the strap and it is earthed, static charge will be
harmlessly bled to ground.

2. Do not remove the component from its anti-static protective packaging until you are
about to install it.

3. Hold boards by the edges - try not to touch components / interface strips etc.

NOTE: We recommend that you return your computer to the service department for
upgrading. Any work carried out is fully guaranteed. Upgrades should only be carried out
by persons who are familiar with handling IC's, as incorrect installation will invalidate the
guarantee.
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System Board Jumper Settings

Fa)
B

/1 CAUTION

Do not move the jumper with the power on. Always turn off the power and unplug the
power cord from the computer before changing a jumper setting. Otherwise, the board
could be damaged.

e Clear CMOS Jumper: CLR_CMOS

The configuration Jumper (CLR_CMOS) allows the user to clear the CMOS. The CMOS
RAM onboard has a power supply from an external battery to keep the data of the
system configuration. The CMOS RAM allows the system to automatically boot OS every
time it is turned on.

T E E s
1 1
Normal Clear Data

(Use a metal object to
temporarily short these

two pins.)
Pin Status
1-2 Normal
2-3 Clear CMOS

Figure 5: Clear CMOS jumper

V1.0 Vig711W Motherboard Manual 17



Motherboard Connectors

There are connectors on the motherboard for the Power supply, HD audio, fans, front
panel audio, front panel USB and front panel connectors. The location and/or details of
these connections are shown below.

Front Panel Connectors: SYS_PANEL

These connectors are for electrical connection to the front panel switches and LEDs. The
SYS_PANEL is compliant with Intel® Front Panel I/0O Connectivity Design Guide.

Table 3:

PWR_LED

(+) | (=) |DN.’UFF|

HHAdOB
i E HiE
(+) (<) [ RESET
HDD_LED

Figure 6: Front Panel Connectors

Front Panel Connectors (Sys_Panel)

Pin

Connector Comments

1-3

Pins 1 and 3 can be connected to an LED to provide a visual

Hard Drive Activity LED indicator that data is being read from or written to a hard drive.
Header Proper LED function requires a Serial ATA hard drive connected to
an onboard Serial ATA connector.

5-7

Pins 5 and 7 can be connected to a momentary single pole, single
Reset Switch Header throw (SPST) type switch that is normally open. When the switch is
closed, the board resets and runs the POST.

2-4

Pins 2 and 4 can be connected to a one- or two-colour LED. This

Power/Sleep LED Header display if the computer is active or not.

Pins 6 and 8 can be connected to a front panel momentary-contact
power switch. The switch must pull the SW_ON# pin to ground for at
least 50 ms to signal the power supply to switch on or off. (The time
requirement is due to internal debounce circuitry on the board.) At
least two seconds must pass before the power supply will recognize
another on/off signal.

Power Switch Header

V1.0
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Power Connectors

External 12V Power Connector

The board can be powered with a 19V DC external power supply through the 19V DC
connector on the back panel. The back panel connector accepts plugs with an inner
diameter of 5.5mm and an outer diameter of 7.5mm.

12vi18vDC
HDMI

USB 3.0/USB 2.0

Figure 7: Back Panel

NOTE:

Note: DC Power connector supports 19V power Adapter. The back panel DC connector
is compatible with a 7.4 mm/OD (outer diameter) and 5.1 mm/ID (inner diameter) plug,
where the inner contact is +19 (£10%) V DC and the shell is GND. The maximum current
rating is 12 A.
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Front Panel Audio Connector: FP_AUDIO

This connector allows you to connect the front panel audio and is compliant with Intel®
Front Panel I/0O Connectivity Design Guide.

HD Audio Front Audio Header

PORTILE§1H 2 GND

PORT 1R 34 | PRESENCE#

PORT2R{5 6 ) Sense1_Ret
Sense_Send

PORT2L {9 10) Sense2_Ret

Figure 8: Front panel audio connector

Key (no pin)

Table 4: Front panel audio header for HD audio

Pin Signal Name Pin Signal Name

1 [Port 1] Left channel 2 Ground

3 [Port 1] Right channel 4 PRESENCE# (Dongle present)
5 [Port 2] Right channel 6 [Port 1] SENSE_RETURN

7 SENSE_SEND (Jack detection) | 8 Key (no pin)

9 [Port 2] Left channel 10 [Port 2] SENSE_RETURN

V1.0 Vig711W Motherboard Manual 20



Front USB Connector: USB20_34, USB20_12

This connector, compliant with Intel® 1/O Connectivity Design Guide, is ideal for
connecting high-speed USB interface peripherals such as USB HDD, digital cameras,

MP3 players, printers, modems and the like.

USB20_12 & USB20_34
Headers

(1@ 2] +5V_DC
3§ 4)D-
506D+

(8 J GND
10 NC

Figure 9: Front USB connectors

+5V_DC

D-

D+

GND
KEY(no pin)

Front USB Connector: USB20 5

USB20_5 Header
(Single)

KEY(no pin)
GND 4]

D+ I3

D- 2
+5v_pc 1

Figure 10: Front USB connector - single

V1.0 Vig711W Motherboard Manual
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Fan Power Connectors: CPU_FAN, SYS_FAN

The fan power connectors support system cooling fan with +12V. When connecting the
wire to the connectors, always note that the red wire is the positive and should be
connected to the +12V; the black wire is Ground and should be connected to GND. The

motherboard has a System Hardware Monitor chipset on-board, which must be used with
fans specially designed with speed sensors to take advantage of the CPU fan control.

CPU_Fan SYS_Fan

a > o d
Z N g X
| o % F '5

GROUND
POWER(+12V)

FAN_FB
FAN_PWM

Figure 11:. Fan Power connectors

Table 5: System FAN header, CPU FAN header

PIN 4-Wire support PIN 3-Wire support
1 GND 1 GND
2 +12V power 2 +12V power
3 FAN_FB 3 TAC
4 FAN_PWM 4 Control
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Serial ATA Connector: SATAO, SATA1

This connector is a high-speed Serial ATA interface port. Each connector can connect to
one Serial ATA device.

Figure 12: Serial ATA Connector

NOTE:

Please do not fold the serial ATA cable into 90-degree angle. Otherwise, data loss may
occur during transmission.
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Upsrading the CPU

CAUTION!

Before installing or removing a processor, make sure the AC power has been removed
by unplugging the power cord from the computer; the standby power LED should not be
lit. Failure to do so could damage the processor and the board.

To install a processor, follow these instructions:

1. Unlatch the processor socket lever by pushing it down and away from the socket.
(Figure 13, A, B)

Figure 13: Unlatch the socket lever

2. Rotate the socket lever to lift the load plate away from the socket (Figure 14, A).
Make sure that the load plate is in the fully open position (Figure 13, B) while being
careful not to damage adjacent components. Do not touch the socket contacts.

Figure 14: Lift the load plate
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3. Remove the processor from its protective cover. Hold the processor only at the
edges, being careful not to touch the bottom of the processor (see Figure 15).

Figure 15: Remove the processor from the protective cover

Note: Do not discard the processor cover. Always replace the processor cover if you
remove the processor from the socket.

4. Hold the processor with your thumb and index finger oriented as shown in Figure 16
to align your fingers with the socket finger cut-outs. Make sure that the processor Pin
1 indicator (gold triangle) is aligned with the Pin 1 chamfer on the socket (Figure 16,
B) and that the notches on the processor align with the posts on the socket (Figure
16, C). Lower the processor straight down without tilting or sliding it in the socket
(Figure 16, A).

Figure 16: Install the processor
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5. Carefully lower the socket lever (Figure 17, A) while making sure that the front edge
of the load plate slides under the shoulder screw cap as the lever is lowered. Latch
the socket lever under the load plate tab (Figure 17, C, and D). The socket cover
(Figure 17, B) will pop off as shown.

Figure 17: Secure the load plate in place

6. Pick up the socket cover and remove it from the desktop board.
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e Connecting the Processor Fan Heat Sink Cable

Connect the processor fan heat sink power cable to the 4-pin processor fan header (see
Figure 18).

Make sure the four hooks are in the proper position before you install the cooler.

If the heatsink is held in by screws, position heatsink correctly and screw into place.

0--——---—-—-1

\_ >,

Figure 18: Connecting the processor fan heat sink power cable to the processor fan header
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Installing & Removing Memory Modules

e Installing Memory

You can install up to 16GB of memory in each of the motherboard SO-DIMM sockets.
The motherboard has two SO-DIMM sockets. The motherboard supports the following
memory features:

o 0O 0O O O

Two DDR3 SO-DIMMs with gold-plated contacts.
Non-ECC (64-bit) memory.

1GB, 2GB, 4GB, 8GB and 16GB modules.

only support Voltage 1.5V

Memory Speeds 1066MHz, 1333MHz & 1600MHz

To install SO-DIMMs, follow these steps:

1. Observe the precautions in “Before You Begin”. Turn off the computer and all
Peripheral devices.
2. Remove the computer cover and locate the DIMM sockets.

3. Holding the SO-DIMM by the edges, remove it from its antistatic package.

4. Position the SO-DIMM above the socket. Align the two small notches in the bottom
edge of the SO-DIMM with the socket tabs. Insert the bottom edge of the SO-DIMM
into the socket.

5. When the SO-DIMM is seated, push down until the retaining arms at either ends of
the socket snap into place. Make sure the clips are firmly in place.

6. Replace the computer cover.

Notch
Socket Tab

Retention
Arms

Figure 19: Memory Installation
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Removing Memory

To remove a SO-DIMM, follow these steps:

Observe the precautions in "Before You Begin”.

Turn off all peripheral devices connected to the computer. Turn off the computer.
Remove the computer cover.

Gently spread the retaining arms at each end of the socket. The SO-DIMM pops out
of the socket. Hold the SO-DIMM by the edges, lift it away from the socket, and store
it in an antistatic package.

5. Reinstall and reconnect any parts you removed or disconnected to reach the SO-
DIMM sockets.

PowpdPRE

4
|
a
<
|
<
-
-

Memory module

Figure 20: Removing Memory Modules
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Replacing the Clock/CMOS RAM Battery

A lithium battery is installed in a socket on the system board.

The battery has an estimated life expectancy of seven years. When the battery starts to
weaken, it loses voltage; when the voltage drops below a certain level, the system
settings stored in CMOS RAM (for example, the date and time) may be wrong.

If the battery fails, you will need to replace it with a CR2032 battery or an equivalent. As
long as local ordinance permits, you may dispose of individual batteries as normal
rubbish. Do not expose batteries to excessive heat or any naked flame. Keep all
batteries away from children.

CAUTION!

Danger of explosion if the battery is incorrectly replaced. Replace only with the same or
equivalent type recommended by Viglen. Discard used batteries according to
manufacturer’s instructions.

To replace the battery, carry out the following:

Observe the precautions in “Before You Begin.”

Turn off all peripheral devices connected to the system.

Turn off the system.

Remove any components that are blocking access to the battery.

Figure 21 shows the battery location. Gently pry the battery free from its socket.
Install the new battery in the socket.

o0 hsWNE

Figure 21: Removing the Battery
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Chapter 3: Solving Problems

The first part of this chapter helps you identify and solve problems that might occur when
the system is in use. The second part lists error code messages that might be displayed.

Please remember that if you cannot solve the problem by yourself then you should
contact Viglen Technical Support for further assistance.

Viglen Technical Support can be reached in the following ways:
Telephone: 01727 201 850

Fax: 01727 201 858

Email: techsupport@viglen.co.uk

You can also look for support information on our web site:

http://www.viglen.co.uk

Device drivers and various useful utilities can be downloaded from our ftp site:

http://download.viglen.co.uk/files/

Resetting the System

Before checking your system for hardware problems, it is always a good idea to try
resetting your computer and see if a re-boot can solve the problem. Most software
related problems can be solved simply by re-booting your PC.

Table 6: Resetting the System

To do the following Press

Soft boot: Clear the system memory and <Ctrl + Alt + Del>
reload the operating system (also called
warm reset).

Cold boot: Clear the system memory, halt | Power off/on or reset button (at front
power to all peripherals, restart POST, and | of the system)
reload the operating system.
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Troubleshooting Procedures

This section provides a step-by-step troubleshooting procedure to identify a problem and
locate its source.

CAUTION!

1. Turn off the system and any peripheral devices before you disconnect any peripheral
cables from the system. Otherwise, you can permanently damage the system or the
peripheral devices.

2. Make sure the system is plugged into a properly grounded power outlet.

3. Make sure your keyboard and video display are correctly connected to the system.
Turn on the video display, and turn up its brightness and contrast controls to at least
two-thirds of the maximum (refer to the documentation supplied with the video
display).

4. If the operating system normally loads from the hard disk drive, make sure there is no
diskette in the diskette drive. If the operating system normally loads from a diskette,
insert the operating system diskette into the drive.

5. Turn on the system. If the power indicator does not light, but the system seems to be
operating normally, the indicator is probably defective. Monitor the power-on self test
(POST) execution. Each time you turn on the system, the POST checks the system
board, memory, keyboard, and certain peripheral devices.

NOTE: If the POST does not detect any errors, the system beeps once and boots up.

Errors that do not prevent the boot process (non-fatal errors) display a message that
looks similar to the following:

Error Message Line 1

Error Message Line 2

Press <DEL> for Set-up, <F1> to Boot

You can note the error and press <F1> to resume the boot-up process, or <DEL>
to enter Set-up.

Errors that prevent the boot process from continuing (fatal errors), are communicated by
a series of audible beeps. If this type of error occurs, refer to the error codes and
messages listed at the end of this chapter.

6. Confirm that the operating system has loaded.
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Problems & Sugsgestions

Table 7: Problems and Suggestions

What happens

What to do

Application software
problems

Try resetting the system.
Make sure all cables are installed correctly.
Verify that the system board jumpers are set properly.

Verify that your system hardware configuration is set correctly. In
Setup, check the values against the system settings you recorded
previously. If an error is evident (wrong type of drive specified, for
example), make the change in Setup and reboot the system. Record
your change.

Make sure the software is properly configured for the system. Refer to
the software documentation for information.

Try a different copy of the software to see if the problem is with the
copy you are using.

If other software runs correctly on the system, contact the vendor of
the software that fails.

If you check all of the above with no success, try clearing CMOS
RAM and reconfiguring the system. Make sure you have your list of
system settings available to re-enter, because clearing CMOS RAM
sets the options to their default values.

Characters on-
screen are distorted
or incorrect

Make sure the brightness and contrast controls are properly adjusted
on the monitor.

Make sure the video signal cable and power cables are properly
installed.

Make sure your monitor is compatible with the video mode you have
selected.

Characters do not
appear on screen

Make sure the video display is plugged in and turned on.
Check that the brightness and contrast controls are properly adjusted.
Check that the video signal cable is properly installed.

Make sure a video board is installed, enabled, and the jumpers are
positioned correctly.

Reboot the system.
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Table 8: Problems and Suggestions (Continued)

What happens

What to do

CMOS RAM settings
are wrong

If system settings stored in CMOS RAM change for no apparent
reason (for example, the time of day develops an error), the backup
battery may no longer have enough power to maintain the settings.
Replace the battery (Chapter 2).

Diskette drive light
does not go on when
drive is in use or is
tested by POST

Make sure the power and signal cables for the drive are properly
installed.

Check that the drive is properly configured and enabled in Setup.

Hard drive light does
not go on when drive
is in use or is tested
by POST

Make sure the power and signal cables for the drive are properly
installed.

Make sure the front panel connector is securely attached to the
system board headers.

Check that the drive is properly configured and enabled in Setup.

Check the drive manufacturer's manual for proper configuration for
remote hard disk drive activity.

Power-on light does
not go on

If the system is operating normally, check the connector between the
system board and the front panel. If OK, the light may be defective.

Prompt doesn't
appear after system
boots

It's probably switched off.

A serious fault may have occurred consult your dealer service
department / Technical Support.

Setup, can't enter

If you can't enter Setup to make changes, check the switch that
disables entry into Setup (Chapter 2). If the switch is set to allow
entry into Setup, you might need to clear CMOS RAM to the default
values and reconfigure the system in Setup.

System halts before
completing POST

This indicates a fatal system error that requires immediate service
attention. Note the screen display and write down any beep code
emitted. Provide this information to your dealer service department /
Technical Support.

V1.0
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Chapter 4: System BIOS

What is the BIOS?

The BIOS (Basic Input Output System) is an important piece of software which is stored
in a ROM (Read Only Memory) chip inside the computer. It consists of the basic
instructions for controlling the disk drives, hard disk, keyboard and serial/parallel ports.
The BIOS also keeps a list of the specifications of the computer in battery-backed RAM
(also known as the CMOS RAM) and provides a special Setup program to change this
information.

The BIOS in your Viglen computer is guaranteed to be fully compatible with the 1BM
BIOS. It has been written by American Megatrends Inc, an industrial leader in the field of
BIOS software.

The Power-On sequence

When the computer is first switched on, certain instructions in the BIOS are executed to
test various parts of the machine. This is known as the POST (Power-On Self Test)
routine. When you switch the computer on (or when you press the Reset button or press
<Ctrl> + <Alt>+ <Delete> keys, which has the same effect), you can see on the monitor
that it counts through the memory, testing it. The floppy disk drives are then accessed
and tested, and the various interfaces are checked. If there are any errors, a message is
displayed on the screen.
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BIOS Upgrades

A new version of the BIOS can be upgraded from a bootable USB key using the
AMIDEDOS.EXE utility or in Windows using the AEFUWIN utility that is available from
the Viglen FTP site. This utility does BIOS upgrades as follows:

e Updates the flash BIOS from a file on a disk or within the location of the utility.
e Updates the language section of the BIOS.

e Makes sure that the upgrade BIOS match the target system to prevent accidentally
installing BIOS for a different type of system.

BIOS upgrades and the AMIDEDOS.EXE utility is available on the Viglen FTP site
http://download.viglen.co.uk/files/

NOTE: Please review the instructions distributed with the upgrade utility before
attempting a BIOS upgrade.

Using AMIDEDOS.EXE to update the BIOS
The BIOS can be updated using the AMIDEDOS.EXE utility in DOS environment.

Save BIOS update zipped file to a temporary directory.

Extract the necessary files.

Copy the contents of the file to a bootable floppy disk, USB device or CD-ROM.
Boot the target PC with the device connected or inserted.

Select F7 during POST to display the Boot Menu and select your bootable device.
Type 'Flash.bat' to launch the BIOS update process.

The system will reboot once complete.

NoohkrwhpE

DO NOT shutdown or reset the system while updating the BIOS! Doing so may
cause system boot failure!

When the BIOS update process is complete, the utility reboots the system.
Once the system has been restarted, the following steps need to be completed before
starting Windows.

1. Enter the BIOS setup by pressing DEL

2. Once in the setup load the optimized settings by selecting ‘Load Optimized
Defaults’

3. Exit the setup by selecting ‘Save & Exit setup’.

4. Now boot in to windows.
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BIOS Setup
This chapter provides basic information on the BIOS Setup program and allows you to
configure the system for optimum use. You may need to run the Setup program when:

e An error message appears on the screen during the system booting up, and requests
you to run BIOS SETUP.
¢ You want to change the default settings for customized features.

Note: The items under each BIOS category described in this chapter are under
continuous update for better system performance. Therefore, the description may be
slightly different from the latest BIOS and should be held for reference only.

> Entering Setup

Power on the computer and the system will start POST (Power On Self Test) process.
When the message below appears on the screen, press <DEL> to enter Setup or Press
F7 and select ‘Enter Setup’.

Please select boot device:

P1: TSSTcorp CDDUDW SN-208FB

F7 for the Boot Menu

» Control Keys

Table 9: BIOS control keys

<«— —> | Select Screen

i Select Item
<Enter> | Select

+/- Change Opt

F1: General help

F2: Previous values

F3: Optimized Defaults

FA4: Save & Exit

ESC: Exit

Getting Help

After entering the Setup menu, the first menu you will see is the Main Menu.
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Main Menu

The main menu lists the setup functions you can make changes to. You can use the
arrow keys ( 1] ) to select the item. The on-line description of the highlighted setup
function is displayed at the bottom of the screen.

Sub-Menu

If you find a right pointer symbol (as shown in the right view) appears to the left of certain
fields that means a sub-menu can be launched from this field. A sub-menu contains
additional options for a field parameter. You can use arrow keys ( 1| ) to highlight the
field and press <Enter> to call up the sub-menu. Then you can use the control keys to
enter values and move from field to field within a sub-menu. If you want to return to the
main menu, just press the <Esc >.

General Help <F1>

The BIOS setup program provides a General Help screen. You can call up this screen
from any menu by simply pressing <F1>. The Help screen lists the appropriate keys to
use and the possible selections for the highlighted item. Press <Esc> to exit the Help
screen.

The Menu Bar

tio Setup Utility - Copyright (C) 2015 American Megatrend:

Figure 22: Main Menu

Main Menu - Use this menu for basic system configurations, such as time, date etc.
Advanced - Use this menu to setup the items of the BIOS special enhanced features,
integrated peripherals, power management and PC health status.

Monitor - For changing the system monitor configuration settings.

Boot - Use this menu to specify the priority of boot devices.

Security - Use this menu to set supervisor and user passwords.

Save & Exit - This menu allows you to load the BIOS default values or factory

VVVV VYV
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1. Load Optimized Defaults: Use the arrow keys («—, —, 1, |) to select the [Restore
Defaults] in [Save & Exit] menu, and press <Enter>. A pop-up message will appear,
select [Yes] and press <Enter> to load the default settings for optimal system
performance.

Figure 23: Restore Defaults

2. Setup Date/Time: Use the arrow keys (<, —, 1, |) to select the [System Date] /
[System Time] in [Main Menu] menu, and press <Enter>. And then, you can set the
Date, Time in their respective fields.

Figure 24: Setup Date/Time

3. Save & Exit Setup: Use the arrow keys («—, —, 1, |) to select the [Save Changes &
Reset] in [Save & Exit] menu, and press <Enter>. A pop-up message will appear,
please select [Yes] and press<Enter> to save the configurations and exit BIOS setup
utility.

Figure 25: Save & Exit Setup
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Windows 8/8.1/10 BIOS Setting

System configured with Windows 8.1/10 will have following default BIOS settings. It is
strongly recommended that these BIOS settings are not disabled for a Windows 8/10
system.

OS Boot Mode [UEFI OS]
Network Stack [Enabled]
Secure Boot [Enabled]

To configure Windows 7 on this system the BIOS settings must be changed to boot into
Legacy BIOS mode. For Windows 7, OS Boot Mode should be changed to [Legacy OS]

Please ensure the changes of the following settings are performed by personnel with some
previous experience/knowledge of altering BIOS settings.

Accessing BIOS Setup

To access the BIOS, Press the F7 key during POST for the boot menu to appear and
then select ‘Enter Setup’

Enabling/Disabling Windows 8/10 Features

1. From the BIOS main menu select the ‘Boot’ tab.

io Setup Utility - Copyright (C) 2015 American Megatrend

System Date

Figure 26: Main menu
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2. In the ‘Boot configuration menu change following settings:

OS Boot Mode [Legacy OS]
Launch PXE OpROM policy [Enabled]

Aptio Setup Utility - Copuright ©) 2015 Amer ican Megatrends.

0S Boot Mode [Legacy 0S]

Figure 27: Boot Configuration Menu — Windows 7 settings

For Windows 8.1 and 10 following settings should be set:

OS Boot Mode [UEFI OS]
Network Stack [Enabled]

Aptio Setup Utility Copyright (C) 2015 American Megatrends.,

Setup Prompt Timeout

Figure 28: Boot Configuration Menu — Windows 8/10 settings
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Enabling Secure Boot

It is recommended that ‘Secure Boot’ is set to ‘Enabled’ to initialize the Windows 8/10
secure boot feature when the system boots up.

Note: Secure boot is supported under Windows 8/8.1 and Windows 10. This feature
helps in preventing malicious software applications and "Unauthorized" operating
systems from loading during the system start-up process.

To Enable Secure Boot

In the Boot configuration menu ensure OS boot Mode is set to [UEFI OS].

1.

From the BIOS tab options select the ‘Security’ tab and select the ‘Secure Boot
menu’ option.

Aptio Setup Utility Copuyright (C) 2015 American Megatrends. Ii

Key Management

Figure 29: Boot Configuration Menu — Windows 8/10 settings
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2. Once Secure Boot is set to ‘Enabled’ set the Secure Boot Mode to ‘Custom’

Aptio Setup Utility Copuyright () 2015 American Meg

Key Management

Figure 30: Secure Boot Enabled/Disabled option

3. In Custom mode scroll down the active options in the Security Tab option list and
Select the ‘Key Management’ Option.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Figure 31: Secure Boot
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4. In the Key management options select the ‘Default Key Provisioning’ option and
Set to ‘Enabled’

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Security
Force DEM default Secure Boot
Keys If System Is in Setup Mode
Manage All Factory Keus (PK,KEK,DB,DBX)
Install default Secure Boot keys
Platform Key (PK) NOT INSTALLED
» Set PK from File
» Get PK to File
» Delete the PK
Key Exchange Key Database(KEK) NOT INSTALLED
I Set KEK from File Default Key Provisioning
|» Get KEK to File Disabled
||» Delete the KEK Enabled
» Append an entry to KEK Select Screen
Authorized Signature Database (D) : Select Item
» Set DB from File Enter: Select
» Get DB to File +/-: Change Opt.
» Delete the DB F1: General Help
» Append an entry to DB F2: Previous Values
Forbidden Signature Database(DBX) NOT INSTALLED F3: Optimized Defaults
» Set DBX from File F4: Save & Exit
» Get DBX to File ESC: Exit
» Delete the DBX
» Append an entry to DBX

Copyright

Figure 32: Default Key Provisioning

5. In the Key management options select the ‘Install default Secure Boot Keys’ option
and confirm Installation in the pop up to install the default secure Boot Keys.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Security
Default Key Provisioning [Enabled] Force System to User Mode -
install default Secure Boot
Manage All Factory Keys (PK,KEK,DB,DBX) Variables(PK ,KEK,db,dbx) .
Change takes effect after
reboot
Platform Key (PK) NOT INSTALLED
» Set PK from File
» Get PK to File
» Delete the PK Load Default Secure Variables
Key Exchange Key Databa
» Set KEK from File Do you really wish to Install Factory
» Get KEK to File Default secure variables?
» Delete the KEK
» Append an entry to KEK ect Screen
Authorized Signature Dat Item
» Set DB from File Select
» Get DB to File ange Opt.
» Delete the DB F1: General Help
» Append an entry to DB F2: Previous Values
Forbidden Signature Database(DBX) NOT INSTALLED F3: Optimized Defaults
» Set DBX from File F4: Save & Exit
» Get DBX to File ESC: Exit
» Delete the DBX
» Append an entry to DBX

Copyright (C) 2012 Aamerican Megatrend

Figure 33: Default Secure Boot Keys
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5. Once the Default Secure Boot keys are installed it will state ‘Installed’ as shown in
below image

Install default Secure Boot keys

Figure 34: Default Secure boot keys
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Disabling Secure Boot

1.

Aptio Setup Utility - Copyright
Security

(C) 2012 Amer ican Megatrends,

Inc.

Manage All Factory Keus (PK,KEK,DB,DBX)
Install default Secure Boot keuys

INSTALLED

Platform Key (PK)

Set PK from File

Get PK to File

Delete the PK

Keuy Exchange Key Database (KEK)
Set KEK from File

Get KEK to File

pelete the KEK

Append an entry to KEK
Authorized Signature Database(D
Set DB from File

Get DB to Flle

Delete the DB

Append an entry to DB

b 4 28 4

INSTALLED
pefault Key Provisioning
Disabled
Enabled

, O &%, A

b & dB A 4

Delete the DBX
Append an entry to DBX

L 3 i A5, /

Force OEM default Secure Boot
Keys if System is in Setup Mode

Enter: Select
+/=1

Forbidden Signature Database(DBX) INSTALLED F3: Optimized Defaults
set DBX from File F4: Save 8 Exit
Get DBX to Flle ESC: Exit

: Select Screen
Select Item

Change Opt.
: General Help
: Previous Values

Figure 35: Default Key Provisioning

In the Key management options select ‘Default Key Provisioning’ and Set the
option to ‘Disabled’

2. Select ‘Clear Secure Boot Keys’ and confirm Installation in the prompt pop up to

clear the default secure Boot Keys.

Aptio Setup Utility - Copyright

(c)
Security

2012 American Megatren

Default Key Provisioning [Disabled]

Manage All Factory Keys (PK,KEK,DB,DBX)

Platform Keu (PK)

» Set PK from File

» Get PK to File

» Delete the PK
Key Exchange Key Databas]

» Set KEK from File

> Get KEK to File

» Delete the KEK

» Append an entry to KEK
Authorized Signature Dat

» Set DB from File

» Get DB to Flle

» Delete the DB

» Append an entry to DB
Forbidden Signature Database(DBX)

» Set DBX from File

» Get DBX to File

» Delete the DBX

» Append an entry to DBX

INSTALLED

Reset Platform to Setup Mode

Do you really wish to reset Platform to
Setup Mode?

F1:
F2:
F3:
Fdq:

INSTALLED

Force System to Setup Mode -
clear all Secure Booot
Varliables. Change takes effect
after reboot

ESC: Exit

ect Screen
ect Item

General Help
Previous Values
Optimized Defaults
Save & Exit

Figure 36: Reset platform

V1.0 Vig711W Motherboard Manual

46



3. Once the secure Boot keys are cleared it will state ‘Not Installed’ as shown in

below

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Security

Manage All Factory Keys (PK,KEK,DB,DBX)
Install default Secure Boot keys
Platform Key (PK) NOT INSTALLED
Set PK from File

Get PK to File

Delete the PK

Key Exchange Key Database{(KEK)
Set KEK from File

Get KEK to Flle

Delete the KEK

Append an entry to KEK
Authorized Signature Database{(DB)
Set DB from File

Get DB to File

bDelete the DB

Append an entry to DB

Forbidden Signature Database(DBX)
Set DBX from File

Get DBX to File

Delete the DBX

Append an entry to DBX

, 2 2% 4

NOT INSTALLED

L BB A

NOT INSTALLED

b 4B % A J

NOT INSTALLED

vyYywyy

Force OEM default Secure Boot
Keys If System Is In Setup Mode

+¢: Select Screen

Ti: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: ExIit

Figure 37: Clear Secure Boot Keys’

4. Press Esc to exit the Key provisioning Menu.
5. Select ‘Secure Boot’ and set the option to ‘Disabled’

Once all BIOS settings have been configured press F4 key to Save and Exit the BIOS

Setup.

Aptio Se
Securlty

up Utility - Copyright (C) 2012 American Megatrends, Inc.

Password Description

The Administrator's password has the highest
level.User's p rd and P rd Check
only can be changed when Administrator's
password is set.Administrator's password has
the authority to uninstall user password.
The password length must be
in the following range:
Hinimum length

Maximum length

Administrator Password
User Password

Secure Boot
Disabled
Enabled

Administrator Password
User Password

Password Check [(Setup]
Suystem Mode state Setup
Secure Boot state Disabled
Secure Boot Mode [Custom)

» Image Execution Pollicy

alsecure Boot flow control.

Secure Boot Is possible only
1f System runs In User Mode

++: Select Screen

Ti: Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Figure 38: Disabling Secure boot

For Non UEFI OS support (Windows 7) secure boot keys must be set to default and secure boot
disabled. Otherwise system will not detect SATA hard disk drive under boot menu.
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Chapter 5: Sugsgestions

Viglen is interested in continuing to improve the quality and information provided in their
manuals. Viglen has listed some questions that you may like to answer and return to
Viglen. This will help Viglen to keep and improve the standard of their manuals.

1. Is the information provided in this and other manuals clear enough?

2. What could be added to the manual to improve it?

3. Does the manual go into enough detail?

4. Would you like an on-line version of this manual?

5. How do you rate the Viglen Technical support and Service Departments?
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6. Are there any technological improvements that could be made to the system?

7. Other points you would like to mention?

Please return this slip to: Product Development Dept.
XMA Ltd.
7 Handley Page Way
Colney Street
St Albans
Hertfordshire
AL2 2DQ
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